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What is EverWeb?

EverWeb is a complete drag and drop website building tool, letting you create 
professional, fast loading websites without any technical knowledge or coding skills.

EverWeb not only makes it easy to create a website, but it also allows you to enhance 
your website with advanced widgets. Widgets can be used to add E-commerce 
features, Google Maps, Contact Forms, Facebook Like buttons and more.

EverWeb also includes one click publishing to get your website online as fast as 
possible.

�
Figure 1: EverWeb’s user interface. Clean, and simple, EverWeb makes it extremely easy for anyone to build a 

beautiful website.
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EverWeb Standalone Vs. EverWeb + Hosting

EverWeb comes in two versions; EverWeb Standalone and EverWeb + Hosting. Please 
note, no matter which version you choose to buy you will never lose access to the 
license you purchase, even if you do not wish to renew your account. EverWeb is 
NOT a subscription service.

EverWeb Standalone
The EverWeb Standalone version comes with one year of upgrades and support. If you 
do not wish to purchase another year of upgrades or support, you can continue to use 
the version you purchased. You will never lose access to the software you purchased.

With this version you will have to purchase web hosting separately.

EverWeb Standalone costs $79.95 per license.

EverWeb + Hosting - starting at $99.95 USD/year
The EverWeb + Hosting comes with the software, hosting and emails. In addition, it has 
a few more features including;

1. Password protection

2. 404 Not Found Pages

3. 301 redirects to redirect old web pages to your new EverWeb site and retain your 
search engine rankings

4. Free upgrades and support while you have an active account

5. You will not lose access to the software you purchased if you do not renew your 
account

The EverWeb + Hosting version will also let us more efficiently help you should 
problems arise because we have access to the server that your website is on. You only 
have to deal with one company for any of your website issues.

EverWeb + Hosting starts at $99.95 USD/year.

Purchasing EverWeb
You can quickly and easily purchase EverWeb by following the link below. Licenses are 
immediately delivered so there is no wait to getting your website online;

Purchase an EverWeb License
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The Projects Window
The projects window will be the first thing you see each time you launch EverWeb 
(Figure 2).

The projects window consists of your EverWeb sites, and two buttons. One button for 
creating a new site, and another button to take you to the EverWeb video tutorials page.

Whenever you want to create a brand new site in EverWeb, you will click on the ‘Create 
a new website’ button.

If you do not have any saved projects in EverWeb, your recent projects list will be 
empty, but if you do have one or more saved projects, you will see them in this list. To 
open a saved project, simply double click on the project.

If you have a project that you want to delete, just select the project and press the Delete 
key on your keyboard. You can also click on the arrows next to the project name, and 
then select the Delete option.
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Figure 2: The Projects window can be accessed from the File menu->Projects. It lists your current websites and lets 
you create new website.
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The User Interface
Before beginning to build your website, it is important to become familiar with 
EverWeb’s user interface (Figure 3).

On the left hand side of the window (Figure 3 - Section A), is where all of your website's 
pages will appear. You can adjust the width of this area by hovering your cursor over the 
divider, and then clicking and dragging to the left or right.

Tip: To rename a page, or your website name, select the page you want to rename and press the ‘Return’ 
key on your keyboard. Page names should only contain letters and numbers. Any spaces will be 
converted to a ‘-’ when publishing.

On the bottom of the window, you will see the toolbar (Figure 3 - Section B) which 
allows you to do things such as add a new page, a shape, or a text box to name a few.

On the right hand side, you will see the Inspector window (Figure 3 - Section C) which 
has all of the features for modifying the elements on your website. We will talk about 
each of these features in more detail later on.

You also have the Assets section for managing all of your site's images.

Lastly, there is the Widgets section which contains all of the widgets for easily adding 
items to your website. We will also go over each of the widgets in more detail in later 
tutorials. 

The main area of the window is the Design Canvas (Figure 3 - Section D) where you will 
be able to create or modify a website.

Tip: If you are using a computer with a small screen, you may want to hide the Inspector window to give 
you a bit more room for editing your site. To hide the Inspector window, just go to Window > Hide 
Inspector. You can also use the keyboard shortcut by pressing Command, Option and I. 
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Positioning Objects in EverWeb’s Design Canvas
EverWeb is a drag and drop website builder which means you design your entire 
website by dragging and dropping content; text, images, shapes and widgets, within the 
Design Canvas.

EverWeb’s design canvas is broken up into 3 sections. The header, the main content 
area, and the footer. Objects places within the header and moved down, adjust the top 
position of objects placed within the main content area and footer. Likewise, objects 
added to the main content area will adjust the top position of the footer objects as they 
are moved down.

This allows you to design each section of your page while making sure enough room is 
provided for your header, content and footer and prevents you from having to re-arrange 
objects each time you want to modify these sections. This becomes extremely useful 
when using Master Pages as described in the next section.

To see the different section use the Window menu->Show Layout option. You’ll notice 
now that the borders of each section are displayed. To explicitly adjust the height of 
each area go to the Inspector->Page Settings->Page Layout section. But remember as 
you add objects to each of these sections their height will be adjusted to accommodate 
these objects. So in essence, these settings in the Inspector set the minimum height for 
each section.

You can start by adding a Text Box or Shape from the Toolbar at the bottom. It will be 
created within the Content Area of EverWeb’s Design Canvas. As you move the object 
around, you’ll notice that the main content area’s height is adjusted once you approach 
the bottom border.

If you want to move objects between sections, hold down the COMMAND key on your 
keyboard as you drag the object into another section. Let go of the COMMAND key and 
you’ll notice the object is now ‘trapped’ in the next section.

If you don’t want an object to be able affect the height of a section go to Inspector-
>Metrics and select the ‘Allow free dragging’ option. Now the object can be dragged 
anywhere on the Design Canvas without affecting the height of each section.

Remember when working with EverWeb’s Design Canvas that;

1. It is split up into 3 sections, a header, content area and footer

2. Hold down the COMMAND key on your keyboard to move objects between sections
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3. Set the minimum height of each section from the Inspector->Page Settings->Page 
Layout section  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Figure 3: EverWeb’s user interface consists of 4 main sections. Not pictured are the Assets and Widgets windows, 
which can be accessed by clicking on the tab labeled Assets and the tab labeled Widgets, respectively. 
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Starting A New Site & Adding Pages
You can begin a new website by clicking on the 'Create a new website' button which is 
located on the Projects Window (See Figure 1 above).

Doing so will prompt EverWeb's template selector to appear (Figure 4). Choose from 
one of the many templates in the template list on the left, and then select one of the 
pages for that template. Starting with one of the templates will make the most sense in 
most occasions. If you plan on building your site from scratch, you can use the Blank 
template. Highlight the page and click the ‘Select’ button. 

You can also add more pages to your site by clicking on the ‘Add Page’ button in the 
bottom left corner, and selecting the new page that you want to add. The page will then 
appear in the page list on the left. 

Alternatively, if you just want to add a page that looks identical to one of your pages, 
you can do a secondary click on the page name, and select ‘Duplicate’. This is 
essentially copying and pasting an entire page. If most of your pages follow a similar 
design, consider using the Master Pages feature which is discussed in the next section. 

�

Figure 4: The template window is where you will select the page that you want to use for your site. Those 
building their sites from scratch should start with the Blank template.
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Adding Subpages For Drop Down Menus
EverWeb comes with the ability for users to have directories. What this means is that a 
user can have a page that is within a child directory and include that page in your 
navigation menu in drop down form. To further describe directories, let's take a look at 
an example.

Assume Josh is a real estate agent and has houses for sale, and houses for rent. Josh 
might have two URLs for his website for each of the products that he offers. The two 
URLs might be

1) http://www.joshsrealestate.com/forsale.html 
2) http://www.joshsrealestate.com/forrent.html

His navigation menu on his website might look something like this:

�

However, if Josh wanted to group these two items into one category, he can create a 
directory so that the URLs will be  

1) http://www.joshsrealestate.com/houses/forsale.html 
2) http://www.joshsrealestate.com/houses/forrent.html 

And his navigation menu might look something like this:

Figure 5: Navigation menu in EverWeb. Take note of the links for “For Sale” and “For Rent”
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�

This is a good way to organize items on your site and keep your navigation menu clean 
and simple while still powerful enough for your visitors to navigate with ease. 

Please note that whenever the navigation menu is mentioned, the Navigation Menu 
widget that is included in EverWeb is what is being referred to. The navigation menu 
widget will be discussed further, later on.

To add a directory, click on the ‘Add Directory’ button (bottom left corner in 
the toolbar). Select the template you want to use from the templates 
window. You will now see that you have a new page, but it will not have 
the normal page icon you are used to. Instead, the icon will look like a 
folder, or a directory. Remember, this is still a page on your site, so you 

will need to treat it like any other page.

Now, you can begin adding pages within this directory. Simply select the directory in the 
web page list, and click on the ‘Add Page’ button to add a new sub page. You will notice 
that this page is now beneath the directory, and slightly to the right. 

If you hover your mouse over the parent page navigation menu link within EverWeb’s 
design area, you will see the drop down menu. 

By default, your navigation menu label for each page will be the file name. Since file 
names can only have letters and numbers in them, EverWeb also provides the 
Navigation Display Name field which will override the file name in the navigation menu. 
This can be accessed from the Page Settings tab in the Inspector. You can add any 
label you want here and it will appear in the navigation menu.

The navigation menu contains a lot of customization options. This includes modifying 
the fonts, styles, background colors and more. 

Figure 6: Drop-down navigation menu in EverWeb. The “For Sale”  & “For Rent” links are now in a drop-down menu.
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Fonts and styles can be changed from the Text Settings tab in the Inspector or the 
Fonts button in the Toolbar.

The background appearance can be changed from the Shape Settings tab in the 
Inspector. You can use any of the ‘Fill’ settings for the main level of the navigation menu.

To adjust the background colors of the drop down menu make sure your navigation 
menu is selected and go to the ‘Widget Options’ tab in the Inspector.
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Master Templates
EverWeb supports Master Templates (master pages) which means that you can design 
your website once and have all your pages use that design. When you want to make a 
change to your design, simply edit your Master Template and all pages that use that 
Master Template will be automatically updated.

Creating a Master Template
To create a Master Template, drag the splitter bar at the top of your web page list down 
to reveal the Master Templates page list. Then click the New Master Page button to 
bring up the templates window, and add a page to use for your master page.

Creating a Master Template is just like creating a regular page. You can design it 
however you like, adding shapes, text or images.

You can have as many Master Pages as you want. So for example you can create one 
for your desktop site and one for your mobile site.

Using Master Templates
Once you have created your Master Templates, you need to assign them to your actual 
web pages. To do this, select your page in the Web Page List. Then look to the 
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Inspector on the right and select the Master Template you want to use for that page as 
shown in the screenshot below;

The web page will now reflect the design of the master page. You can also add new 
shapes, text or images to the web page to enhance the design of individual pages.

Tip: Objects from the Master Template cannot be moved or altered from the child page. You will have to 
go back to the master template to make any changes to its design.

To quickly see which objects are part of the Master Template, and which are part of the 
web page you are working with, use the ‘Show Layout’ option under the Window menu. 
Master Template objects will have a small, black page icon next to them.

When working with Master Pages you will usually want to design the header and footer 
sections of your page and fill in the actual content on each individual page. In almost all 
cases, the content height will be different for each page.

For your master page, you will want to set a small content height under Inspector->Page 
Settings->Page Layout section. Then, on your actual pages, any content you add to 
them will push the height the content area down. That way, you can fit any amount of 
content in your actual pages.
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You’ll notice that you can’t explicitly set the content height of each page that uses a 
Master Page. As noted above, as you add objects to the content area of your actual 
pages, the content area will expand to a longer size to accommodate them.

So when working with master pages, remember;

1. Set the content height to something small, such as 100 pixels. Basically the 
minimum height any of the actual pages will be that use this Master page. You can 
do this from the Inspector->Page Settings->Page Layout section.

2. Use your master page to design a common header/footer for each of your pages

3. You can have multiple master pages. For example one for desktop pages and one 
for mobile pages

4. You can’t explicitly set the height of each section on the actual pages that use your 
master page. However, objects you add to each section will adjust the height as 
needed to accommodate them, allowing you to pages with dynamic heights while 
still sharing the same master page

5. Use the Window->Show Layout option in your menu bar to quickly see which objects 
come from your master page. They will have a small, black file icon in the top right 
corner. You must go back to the Master Page to adjust any of these objects.

The Web Page List
On the left hand side of the application, you will see your website name, with all of the 
web pages listed beneath it (Figure 7). Each page has an icon next to it. The icon will 
either be red or white. A white icon will mean that this page has not been modified since 
the last time you have published the site. A red icon will mean that this page has been 
modified since the last publish and will need to be published again in order for the 
changes to be reflected online. The same principle applies to the directory icons.

Remember, you can change the name of these pages by clicking on the Page Settings 
tab in the Inspector window, and then changing the name under File Name. 
Alternatively, you can double click on the page in the page list and edit the name. You 
can also change the Site name by double clicking on it. 
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Introduction To EverWeb’s Toolbar
The toolbar (Figure 8) lets you do common actions such as add new pages, add new 
design shapes or text, change text fonts and more. 

• Add Page: Opens the template chooser and lets you add a new page to your website 
based on a template or with a blank page

• Add Directory: Directories are folders that contain sub webpages. They are mostly 
useful for organizing your website and creating drop down navigation menus which 
are discussed in more detail later on.

• Preview: Preview your website in different web browsers.

• Publish: See the Publishing section in this Manual. This button will publish your 
website.

• Text Box: The button lets you add text to your website. Text can be formatted 
however you’d like and dragged anywhere on your website.
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icon indicates no modifications have been made.
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• Shapes: EverWeb comes with a number of Shapes built in to help you design your 
website. Shapes can be solid colors, gradients or images. See the Inspector-> ‘Shape 
Options’ for customization options

• Rotate: The Rotate button will rotate the select shapes by 90 degrees clockwise. Hold 
down the option key to rotate counter clockwise.

• Fonts: The Fonts button will open up the Font panel and let you modify the selected 
fonts of any selected text box.

• Colors: The Colors button will open your color selector and let you change the text 
color of any selected shapes

• Media: Allows you to access EverWeb’s Media browser

• Mask: Allows you to quickly crop an image
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Inspector Window

Page Settings

Page Details
The first tab in the Inspector window is the Page Settings tab. Here is where we will 
make adjustments to the settings for each page on our site.  

The first option on the page details tab (Figure 9) is for the File Name. The File Name is 
what you will see in your web browser's address field. Some users might name the file 
name after what the page is about, for example, Home, About Us, Contact Us, Services, 
Products, etc. 

You will notice that as you change the file 
name, the changes will also appear in the 
Web Page list. The File Name is one of 
the topics that we discuss in the SEO For 
EverWeb Video Course, so if search 
engine optimization is important for your 
site, you may want to take a look at that 
tutorial before giving your page's file 
names.

The Navigation Menu Display Name is the 
text that will appear in your navigation 
menu should you decide to use EverWeb's 
built in navigation menu. 

The navigation menu display name is 
another one of the elements to optimize 
for search engines so be sure to check out 
the navigation menu video tutorial in the 
SEO For EverWeb Video Course.

We will be discussing the navigation menu 
in more detail in another tutorial. You have 
the option of including each page on your 
site in the navigation menu or not. By 
default, each page will be included in the 
navigation menu, however, if you do not 
want it to be, simply uncheck the “Include 
page in navigation menu” option.
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The web page title will appear at the top of your page in the web browser. The Web 
Page Title is another element to optimize for search engines so make sure to watch that 
video for more extensive instructions on how to make a good page title. Web page title’s 
should include what your page is about and not be more than 160 characters long.

The web page description allows you to add a description for each page. This 
description will often appear in search engines when your page appears in a search 
engine’s results page. This is another element for search engine optimization so once 
again, be sure to watch that video in our SEO For EverWeb video course. 

Page Layout
The Page Layout section (Figure 10) is where you will define the specs of your page. 
First, you'll be able to choose from a Left Aligned page, a Centered page, and a 
Dynamic Width page. 

The other page layout fields are for 
the boundaries for the website. 

Specifying a value greater than zero 
in the top margin field will create a 
space between your website and the 
highest point of the browser window. 

For example, if you add a shape to 
the page, and move it into the header 
all the way to the top, you will see 
that there is a white space between 
the top of the page and where the 
page begins. This white space can 
be made something different, and we 
will get to that in just a moment. 

The content width will determine how wide you want your website to be. There is no set 
rule for how wide your website should be. However, you should consider that most 
users do not like to scroll horizontally and monitors may be smaller than yours. A good 
value to use is 980 pixels, but that is not a hard limit.

The content height will determine the minimum length of the web page's body. This 
value rarely needs to be changed because the height will automatically adjust based on 
where you place objects (such as text, shapes or images) on your page. For example, 
dragging an object down on your page will increase the height of it. Though you will not 
see the value increase in this field, your page height will still be as long as you make it 
by way of the objects on the page.
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Figure 10: The Page Layout section on the Page Settings tab.
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The header height will determine how long the header will be. Like the content height, 
this will also adjust automatically based on what you have in the header. If you want the 
header to be smaller than the default given on the page, you will need to decrease the 
value.

Finally, the footer height will determine the length of the footer. Like the header and 
content heights, the footer will also adjust automatically based on where you drag the 
objects, and you will also need to decrease the value if you want your footer height to 
be smaller.

Page Background & Browser Background
The page background is what will appear behind all of your content on your page 
(Figure 11). You can choose from four options. ‘None’ will just leave the background as 
white, ‘Color Fill’ will allow you to give the background one solid color, ‘Gradient Fill’  will 
allow you to use two colors that will transition smoothly, or ‘Image Fill’ which will allow 

you to have an image for the 
background.

As mentioned earlier, selecting 
None will set the page 
background to be solid white. 
Color Fill allows you to click on 
the color button which will prompt 
the color window to appear. You 
can make the background any 
color you want it to be.

Gradient Fill will allow you to 
choose two different colors and 
have them blend together.  Each 
color can be chosen by clicking 
on the color button for each 
respective color. Once you have 
your two colors selected, you can 
modify the way you want the 
gradient to appear. For example, 
you can flip the order of two 
colors by clicking on the arrows. 

You can notice the page background changing when doing this. You can also choose 
the direction of the gradient. Toggling between the horizontal and vertical arrows will 
change the direction of the gradient from either horizontal or vertical. Alternatively, you 
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can manually change the direction by adjusting the angle with the toggle, or by clicking 
on the up and down arrows.

If you want to have an image for your background, you will need to choose the image 
from your list of Assets, or from your hard drive by selecting Choose to open the Finder 
window. Once your image has been set as the page background, you can either have it 
set to Scale to Fit, Scale to Fill, Stretch, Original Size, or Tile. The option you choose 
will depend on the image you want as your page background.

If you want, you can add a background shadow to your page by clicking the Shadow 
option. You can select the color for your shadow, and how big you want the shadow to 
be. The shadow option works with any type of page background.

You can also add a browser background to your site. The browser background is the 
background styling behind your content area. For the browser background, there are 
two options. You can choose Color Fill which will allow you to choose a solid color for 
your browser background, similar to the page background. If you want this left as white, 
then you do not need to select anything.

You can also choose to Image Fill the browser background. Again, you can select the 
image from your Assets list or choose to locate the image on your hard drive by 
pressing the ‘Choose’ button. When your browser background image has been set, you 
can leave it as Tiled or change it to Original Size. Again, the option you choose will be 
dependent on the image you have selected to use for your browser background. 

Mobile Settings - Creating mobile optimized pages
EverWeb allows you to create a mobile version of your website. If you are using one of 
EverWeb's built in themes, just click on the ‘Add Page’ button, and select the theme you 
want to use, and then select the mobile page from that theme.

If you want to create your 
own mobile page, feel free to 
do so. Just make sure to set 
your page's content width to 
something mobile 
appropriate. All EverWeb 
mobile theme pages are set 
to a Content Width of 480 
pixels. This fits nicely with 
iOS and most mobile devices.

When your mobile page is ready, you must now assign the Mobile page to one of your 
regular pages. When you do this, EverWeb will automatically show the Mobile page 
when a visitor comes from a Mobile device.
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Figure 12: Mobile Settings
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To set up your mobile redirect, select the page on your Web Page list that should 
redirect to a mobile page. Usually this will be your home, or default page. Then, on the 
Page Settings tab in the Inspector window, once again locate the Mobile Settings 
section (Figure 12) and from the Mobile Page drop down menu, select ‘One of My 
Pages’, and then select the mobile page from the ‘Page’ drop down menu. 

If you have multiple pages for your mobile site, just repeat these steps on those pages. 

When you publish your website, the mobile redirect will be enabled and you will be able 
to test this by visiting your website on your mobile device.

Header/Footer Code
The header and footer code sections allows you to place any type of code or script. Just 
like the rest of the settings on the Page tab, any code or script entered into either of 
these fields will be applied to the respective page only, and not the entire site. Any 
codes placed in the header code section will be placed within the <head> tag in your 
HTML code. Any codes placed in the footer code section will be placed right before the 
closing </body> tag.

This section is more of an advanced feature, and is optional, so if you are not sure what 
to put in these fields, then you most likely do not need to include anything.

Password Protection
EverWeb lets you easily password protect certain parts of your website. For example, 
you can use this to create a members only section on your site, or restrict access to 
certain individuals.

Password protection will only work on EverWeb’s Hosting platform. In addition, it can only be applied to 
Directories added to the Web Page list.

To use password protection, press the ‘Add Directory’ button in the Toolbar. Then press 
the ‘Add’ button under the ‘Password Protection’ section in the Page Settings tab.

You can have unlimited passwords but all usernames must be unique. Also, you cannot 
use single quotes in the username or password field.

Redirects
Redirects are a powerful but advanced feature. Say you have an existing website, such 
as an iWeb site that has been around for a while. You may have high search engine 
rankings for this site or you may have provided these links to other people.
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EverWeb lets you automatically redirect individual pages from your old site to your new 
site using a special type of redirect called a 301 redirect. These redirects have the 
benefit of maintaining your search engine rankings.

To use this feature, enter the full URL of your old page. You can find the old URL by 
simply visiting your old site in your browser and copying and pasting the URL in the 
Path bar at the top of your browser window into this field.

Remember, this feature is for individual pages. Each page on your old website should 
redirect to a unique page on your new EverWeb site. DO NOT just enter your main 
website’s URL for each page. Every redirect page in EverWeb should have a unique 
URL.  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Assets
If you want to add images to your website in EverWeb, there are many ways to do this. 
For example, you can drag the image from your desktop onto the editor. You can also 
drag the image from the Finder window onto the editor. You can also go to ‘Insert’ in the 
menu bar and select ‘Choose’ and then choose the image you want to add. 

You can also add an image by adding a text box or shape:

1) Add text box or shape to your page (any shape will do).
2) Click on the Shape tabs in the inspector window
3) Select Image Fill from the drop down menu. 
4) Click the Choose drop down menu and select Choose which will open the Finder 

window, and then select the image that you want. 

The same method can be applied for adding an image to 
the Page and Browser Backgrounds. 

Any image added to the site will appear in the Assets 
section (Figure 13). You can add any image to this list by 
just dragging the image from your hard drive and 
dropping it in the assets list.

You can then add the image to any page on your site by 
dragging it from the Assets list and dropping it on the 
editor. 

You can see a preview of the image by clicking on the 
eye icon which is to the right of the image in the assets 
list. 

The great thing about the assets list is if you want to use 
the same image multiple times throughout your site, you 
do not need to keep adding the image to the site using 
the methods outlined earlier. When the image is added 
once, it remains in the assets list and you can access it 
no matter what page on your site you are currently on. 

Tip: If a shape is using an Image asset, when you select that shape in EverWeb’s designer it will also be 
selected in the Assets list.
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Figure 13: The Assets list.
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Media Browser

There is one other important, and 
powerful way of adding images to 
your site. If you click on the 
‘Media’ button, EverWeb's media 
browser will appear (Figure 14). 

You can now add images to your site from media 
locations on your hard drive such as iPhoto, and 
your Pictures folder. If you want, you can drag and 
drop additional folders onto the media browser so 
that you can access images from any folder on 
your hard drive. 

Whenever you want to add an image from the 
media browser to your EverWeb site, simply drag 
and drop the image either on the editor or in the 
assets section. 

�  of �27 46

Figure 14: EverWeb’s Media browser
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Shape Options
All About Shapes & Images
You can add a shape to your website by clicking on the Shapes button in the toolbar, 
and then selecting the shape you want to use (Figure 15). Shapes can be made bigger, 
and moved around to your desired location.

The shapes tab in the inspector window is where you will be able to 
make modifications to your shape. 

You can change the type of shape you are using by clicking in the 
drop down menu and selecting the shape you want. 

For each shape, there are three settings that you can make fill 
modifications for. Normal is how the shape will appear when no 
mouse cursor is over it. Mouse Over is how the shape will appear 
when the mouse cursor is hovering over it, and Mouse Down is how 
the shape will appear when the shape has been clicked on.

For the shapes appearance, you will have five options to choose 
from. None, will make the shape transparent. This is essentially 
what a text box is. 

Tip: Any shape can have text on top of it. Simply double click on the shape and 
begin typing. 

Color Fill will allow your shape to have a color. You can click on the 
color icon to change the color of the shape. Gradient Fill will allow 
the shape to be two different colors that will transition smoothly. 

You can also choose Advanced Gradient Fill, which is similar to the 
Gradient Fill but is a more advanced feature that will allow you to 
include more than two colors.

Lastly, you can fill the shape with an image. 

Shapes can also have a line stroke surrounding them. Simply 
select Line from the Stroke drop down menu (see Figure 17). You 
can choose between a solid line, a dashed line, and a dotted line. 
You can make the line any color you want it to be, and then can 
also choose the thickness of the line.

The shape can also be placed into a picture frame. You can choose 
from many different picture frames by clicking on the picture frame 
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Figure 15: Shapes
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thumbnail (Figure 16). You can then modify the thickness of the picture frame by 
adjusting the scale.
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Figure 16: Picture frames can be added to any image, shape, or 
text box.
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You can also add a Shadow to your shape by clicking 
the Shadow option. You can then choose the color for 
the shadow, as well as the location of the shadow. 
You can then play around with the Offset, Blur, and 
Opacity until the shadow appears the way you want it 
to.

You can also add a reflection to your shape, and 
specify how large you would like the reflection to be.

Finally, you can adjust the opacity of your shape, 
which works similar to the reflection. Just drag the 
slider from left to right or from right to left, or use the 
up and down arrows. You can also type the value in 
the text field.
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Figure 17: EverWeb Shape Options
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Metrics
Positioning Objects

When building your website, it will be important to position your text, shapes, and 
images in the proper places that you want them to be. There are different ways to 
position these objects. Let's go over each of those ways.

Keep in mind that the object can be a text box, an image, or a shape. It doesn't matter. 
The same principles apply. 

Let's say you want an object to 
be centered on the page. 
Simply go to the menu bar, and 
select Arrange > Align Objects, 
and then select Center. 

Likewise, you can do the same 
if you want the object to be left 
aligned, or right aligned. You 
can also specify if you want the 
object to be placed at the top of 
the page, the bottom of the 
page, or directly in the middle of 
the page (Figure 18.)

Let's say you want to place the object in a specific location according to X and Y 
coordinates. Just click on the Metrics tab in the inspector window, and then you can 
modify the X and Y values under the position 
heading (Figure 19). This will move the objects 
to the specified coordinates. You will see that 
you can also click on the up and down arrows 
which will move the object as you are changing 
the values. This method can be especially 
helpful when you have multiple objects that you 
want lined up. Simply match the Y values for 
each object if you want them to be lined up 
horizontally, or the X values for each object if 
you want them lined up vertically.
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Figure 19: The position of objects can be changed 
by altering their x and y coordinates. 

Figure 18: Object Alignment
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Allow Free Dragging
You’ll notice when dragging objects around the EverWeb design canvas that you may 
be prevented from dragging the objects out of the header, main content area or footer 
sections. These three sections help you organize your web page design so that 
anything added in the header section can actually move the content in the main content 
area and the footer area down so that you don’t always have to adjust your design each 
time you want to change your header.

The same applies to the main content area, where objects moved downwards here will 
adjust the top position of the objects in the footer.

The ‘Allow free dragging' option tells a shape to ignore these boundaries and lets you 
drag it anywhere on the design canvas. The position of a  ‘free dragging’ object does not 
affect any of the objects in any other section.

Tip: To move objects between sections, hold the command key as you drag them to another section. This 
will places them in the section you drop them into.

Fixed Positioned Objects
EverWeb lets you have fixed positioned elements which means that as you scroll your 
website, the position of the object is always the same. This lets you add features like a 
navigation bar that is always displayed at the top of the browser window, even as the 
page is scrolled.

Under the metric tab you’ll see the ‘Fixed position’ checkbox and the ‘Relative to 
browser left’ option underneath it.

The ‘Fixed position’ option will make sure the object is always displayed exactly where 
you placed it on the design canvas as your page is scrolled vertically or horizontally. 
However, for a ‘Centered Aligned’ page, the default in EverWeb where your page 
content is always centered, the object will be anchored to the left margin of the page. 
This means the object’s left position will move as you resize your browser window. That 
lets you have the effect of a centered, fixed positioned object.

By selecting the ‘Relative to browser left’ option, the object won’t adjust it’s left position 
as you resize your browser. Instead, it stays in the exact same position, no matter if you 
scroll or resize your browser.

Remember the, ‘Relative to browser left’ option is only relevant when using the 
‘Centered Aligned’ page under Inspector->Page Settings->Page Layout section.

Fixed position objects are great for navigation bars that should always appear for the 
user, even if they scroll their browser window. They are also great for including social 
media sharing buttons that you always want visible to your visitors.
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Full Width Objects
If you want to have an object that dynamically resizes its width as you resize the 
browser window, full width objects will let you do this.

Under Inspector->Metrics you will see the ‘Full width’ option which does just that. When 
selecting, objects expand with the size of your browser.

Remember that not all objects can be full width. For example, the image gallery cannot 
yet be full width but the Image Slider can be. For objects that cannot be full width this 
setting will have no effect on them.

A full width navigation bar, or background object is a great example of when to use full 
width objects. They expand with the browser window to create a new affect for your 
visitors.

Distributing Objects
Let's say you have multiple objects beside one another and you want to space them 
evenly. Select all the objects either by using your mouse, or by selecting each object 
while holding down the Command key on your keyboard. Then go to Arrange > 
Distribute Objects > Horizontally (Figure 20).

If the objects were placed vertically, you would do the same thing but select Vertically.
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Figure 20: Multiple objects can be distributed evenly either horizontally or vertically.
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All About Text

To add text to your website, simply click on the Text Box button, which is 
located in the toolbar. A text box will appear on the editor, and you can 
edit it by double clicking inside the text box. Alternatively, if you have text 
on the site already, which might be there from a template, you can also 
double click inside the box to edit the text.

There are two ways to edit your text. If you want to edit some of the text in 
the text box, highlight the text that you want to edit. If you want to edit all 
of the text in the text box, just select the text box on its own. If you want to 
change the font of your text click on the Fonts button, and then select the 
font you want to use. You, can also change the font size by adjusting the 
size using the scroll, or by typing in the font size. 

You can also change the color of the text by clicking on the text color icon which will 
bring up the Colors window.

You can also change the text color by 
using the Colors shortcut located on the 
toolbar. You can also click on the Text tab 
in the Inspector window, and change the 
color by clicking on the color icon which 
will also bring up the Colors window 
(Figure 21).

You can also align the text left, center or  to 
the right. You can align the text to be at the top of the text box, the middle of the text 
box, or at the bottom of the text box.

If you want your text to have a colored background, you can select the Background Fill 
option, and then select the color image to change the color of the background. 

You can alter the line space by adjusting the line height of the text. You can also set the 
before and after paragraph spacing. For example, if you want there to be a larger gap 
between two paragraphs, you can either click after the paragraph and then increase the 
After Paragraph value, or you can click before the paragraph and then increase the 
Before Paragraph value.

You can also modify the Inset Margin value for the text box, so that you can control 
where in the text box your text will be placed. The Inset Margin will apply padding 
around your text and the enclosing text box.
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Figure 21: Modifying text color & alignment.
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Modifying Fonts & Styles
EverWeb makes it easy to work with different fonts and styles. To change the font, size, 
and styling of text you can use the ‘Fonts’ button in the toolbar at the bottom of the main 
window.

Important Note About Fonts on Your Website
Working with fonts online can get tricky because not all users will have the font you 
want to use installed on their computer. When someone visits your website on their 
computer and they do not have the font you used installed, their web browser will 
substitute the font for an alternative, closely matching font.

This can cause formatting issues for some users, especially if they are using a mobile 
device or an operating system that is different than yours.

The font issue is further complicated due to the fact that fonts can have various 
licensing terms that restrict you from using them on your website without purchasing the 
appropriate license or checking with the creator of the font. Even if you use your font on 
your computer, you may not be licensed to use it on your website.

There are four ways around the problem with fonts that each have benefits and 
drawbacks;

1. Use only web safe fonts

2. Use Google Fonts

3. Convert your text to an image

4. Use a custom font

The best and most recommended solutions include; using the Web Safe fonts from the 
Font Panel or using Google Fonts. EverWeb makes working with Google Fonts very 
easy and it is explained in more detail in the next section of this manual.

The other solution is to use the option labelled ‘Export text as Image’ under Inspector-
>Text Settings. For this to work you would select the Textbox you want to convert to an 
image and check the ‘Export text as Image’ option in the Inspector.

You must keep in mind that this option will prevent user’s from being able to copy and 
paste the text and will prevent search engines from being able to ‘read’ the text that has 
been converted to an image. It is not recommended for text other then logos or critical 
text that needs to be displayed exactly the same in all browsers and all devices.

The fourth option can get technical and also requires that you obtain the proper license 
for the font you want to use. You can actually include the font file in your website by 
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following this third party tutorial on how to include custom fonts on your EverWeb 
website.

Remember, custom fonts, even if they are included on your computer for your use, may 
not be allowed to be used on your website. Every font has different licensing restrictions 
so check with the creator of the Font if you are allowed to use your intended font on 
your website. You can usually find the creator of the font by Googling the font name in 
your web browser.

Using Google Fonts With EverWeb
Google Fonts are a free and great way to include custom fonts on your website. 
EverWeb makes it really easy to work with Google Fonts.

Google provides over 600 free fonts that you can use on your website and that are 
guaranteed to work across virtually all browsers and devices. It is your best option to 
provide unique fonts for your visitors.

EverWeb makes it very easy to use Google Fonts on your website. All you have to do is 
follow these steps;

1. Visit the Google Fonts web site and find the font you want to use

2. Once you have found the font (or fonts) you want to use, click the ‘Add to Collection’ 
button next to each font

3. Once you have collected all the fonts you want to use, click the down arrow in the 
top right corner to download the fonts to your computer

4. The fonts will be downloaded to your computer and you can simply double click 
them to install them. You may need to close and re-open the Fonts panel in 
EverWeb (or even quit and relaunch EverWeb in some cases) to see them in the 
Fonts Panel

5. Then just use the fonts as you normally would and EverWeb takes care of the rest 
when you publish your website

A detailed tutorial on using Google Fonts in EverWeb can be found here. This is a third 
party tutorial with detailed instructions and screenshots on using Google Fonts on your 
EverWeb website.
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Hyperlinking Objects
Linking any object in EverWeb is very easy to do. Simply select the object, and click on 
the Hyperlink tab in the inspector window (Figure 22). Check the box to enable as 
Hyperlink. You will then be able to select where you want to link the object to. 

You can choose to link one of your website pages by selecting One of My Pages, and 
then choosing the page that you want to link to from the second drop down menu.

You can choose to link to an external page by typing in the URL you would like to link to. 
If you want the link to open in a new window when the user clicks on the link, select the 
option to Open in New Window.

You can choose to link to a file, which you can choose from on your hard drive.

You can also choose to link to an email message by entering the destination email 
address and subject. When a user clicks on the link, their default email client will open 
with the email address and subject already plugged in. 

If you are linking text, you can edit the hyperlink format for that text. You can change the 
color for how the text will appear normally, how it will appear when the user hovers their 
cursor over the link, how it will appear if a user has visited the link before, and how it will 
appear if the link has been disabled. For each of these options, you can also specify 
whether you want the link to be underlined by clicking on the underlined ‘U’.

The Additional Settings option provides a ‘Nofollow link’ option. When you link to page 
you are implicitly telling your visitors or search engines that this is a recommended page 
by you. Sometimes this may not always be the case. Such as in the obvious situation 
that you are linking to a competitor, or an example of something you may disagree with.

For your actual visitors, the context of your link could indicate that this isn’t actually 
something you recommend. However, search engines will still believe you are vouching 
for this linked page. 

By selecting the ‘Nofollow link’ you are essentially telling search engines that you don't 
actually vouch for this page and that you don’t want to pass your website’s reputation to 
this page. This is important because if you link to a page with a bad reputation 
according to search engines, this can negatively affect your page’s reputation and in 
turn lower your search engine rankings.

Select this option when linking to a page you don’t particularly trust or recommend.
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Linking to PDF file’s or other Files for Download
You can easily link to any file, including PDF files, for website visitors to download from 
the Hyperlinks tab.

From the ‘Link To:’ drop down menu select ‘A File’. Then from the ‘Choose…’ button 
select the the file from your computer that you would like user’s to download. This can 
be anything including; PDF files, word documents, images etc… 

They will appear under the ‘External Files’ section of the ‘Assets’ list. These files are 
copied into your projects folder and copied to your server when publishing your website. 
They will not be downloaded from your actual computer, rather they are downloaded 
from the copy that EverWeb has published to your website for you.

The Publish Window

How To Publish A Site In EverWeb
When you are ready to publish your website in EverWeb, you can click on the Publish 
button in the toolbar. 

If this is your first time publishing in EverWeb, you will see a popup window appear. This 
window will indicate to you that you must sign into your EverWeb account in order to 
publish your website. 
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Figure 22: The hyperlinks tab.
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If you do not have an EverWeb account and wish to create one, you can do so by 
clicking on the Create Account button 
where you will be able to register for an 
account.

If you have an EverWeb account, you can 
click on the Sign In button, which will 
bring up the Preferences window (Figure 
23). In this window, you will be able to 
enter your EverWeb email login and 
password. When you are done, click on 
the Sign In button.

Once you are signed in to your EverWeb 
account, you will be signed in until you 
sign yourself out. This means that you will 
not need to enter your login information 
for any other website you wish to publish.

Once logged in, you can click on your website name to bring up the Publishing Settings. 
Under the Publishing heading, you can choose to publish to your EverWeb Hosting 
account, to a local folder or to a third party FTP server.

If you are publishing to EverWeb, you will see the EverWeb Location settings as shown 
in Figure 24. 

Under the Accounts drop down menu, you can choose which EverWeb hosting account 
you wish to publish to. You will most 
likely only have one account so you 
can leave this as is. If you have 
more than one domain on the 
account, you will see a Domains 
drop down, which will allow you to 
choose which domain to publish to. 
If you only have one domain, you will 
not see this menu.

The Subdirectory field (Figure 25) allows you to publish your website to a different 
location on your server. This is mostly used for testing purposes. For this example, 
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Figure 23: Login to your EverWeb account in order 
to publish your site.

Figure 24: Users publishing to their EverWeb Hosting account with 
be able to select from their multiple accounts (if applicable) and 
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entering the word 'temporary' would publish the site to http://everwebtutorials.com/
temporary, rather than just at http://everwebtutorials.com. The current website published 
at http://everwebtutorials.com would not be overwritten.

If you want to publish your site without the Subdirectory, you will just need to leave the 
Subdirectory field blank.

When you are ready, click on the Publish button in the toolbar, and 
EverWeb will publish your website.

Head and Footer Code
You will notice that there is a field for Head and Footer code. This is an advanced 
feature that lets you add custom code that gets place within the Head section of your 
website or right at the bottom of your website.

This is useful for adding Google Analytics, Statcounter.com or custom Javascript code.

Adding Google Analytics
The Footer field can be used to add your Google Analytics code. Just copy and paste 
your Google Analytics code to this field.

EverWeb Hosting Account
If you don’t yet have an EverWeb account create your account here. EverWeb Hosting 
account pricing starts at $99.95 USD/year and provides web space and personal email 
addresses. It also provides free updates and support while your account is active.
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Figure 25: The Subdirectory field allows users to publish their website to brand new directories on their 
servers. This is especially helpful when a user wants to publish to a temporary location for testing purposes 

without overwriting an existing website.
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When you create an account you will be asked to make a password. This password, 
with your email address, is all you need to publish your website.

Once your account is created enter your Email address in the ‘Email’ field and your 
password in the ‘Password’ field and click Sign In. Under the ‘EverWeb Location’ header 
you will see your website address (also known as your domain name) in the ‘Accounts’ 
drop down menu. It should be automatically selected for you.

The ‘Subdirectory’ field should only be used if you have multiple websites under one 
account. It lets you have a unique website address for each website and will prevent 
any websites from being overwritten.

If you want to have multiple websites you don’t have to worry about your website being overwritten. Just 
enter a unique subdirectory for your second website. EverWeb will warn you if you are overwriting an 
existing website previously published through EverWeb.
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Setting Up Personalized Email Addresses
EverWeb makes it very easy to create and manage personalized email addresses. 
These are emails that will use your domain name in them.

To setup an email address to be associated with your domain name, scroll to the bottom  
of the Publishing Settings Screen. In the Email Addresses section (Figure 26), click on 
the Add button. In the popup window, type in your desired email and select the domain 
you want to associate it with from the drop down menu. If you only have one domain, 
you will not need to select the domain.

Type in your desired password and then retype it to confirm. When you are done, click 
on the Create button.

You should now see your email address in the list.

If you wish to configure your email address in Apple's Mail application, select the email 
address from the list and then click on the Configure in Mail button.

You will then see a popup window letting you know that incoming and outgoing email 
settings were successfully setup. Press the OK button.

Now, open up Mail, and you will see that your email address has been added. 

Tip When you click on the Send Email button, you might see a Verify Certificate popup appear. You can 
either click on the Connect button to continue, or click on the Show Certificate button, and then check the 
option to Always trust the server when connecting your email. This is perfectly safe to do and we 
recommend it.
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Figure 26: Setup personal email addresses in EverWeb.
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404 Not Found Page
A 404 Not Found Page lets you assign a page that should be shown if a visitor to your 
website tries to access a page that doesn’t exist. This usually happens if they have an 
outdated link, mistype a page on your site, or you update your site and remove an 
existing page.

FTP Publishing
EverWeb lets you publish your site to any web hosting provide with the FTP Publishing 
option. Your FTP publishing settings can only be obtained from your web hosting 
provider.

Please pay special attention to the username and password field. Often times you will 
have an Account login and an FTP login. Your Account login will let you login to your 
web hosting provider’s website to access billing and account details. In contrast, your 
FTP login details are what is needed in EverWeb’s publishing settings screen.

Often times users confuse these two logins which results in authentication errors when 
trying to publish.

The other field to pay close attention to is your Directory/Path field. This will be the 
directory path to the location that stores your web page files. It can differ between web 
hosting providers and only your actual web host provider will know the correct path to 
enter here. If you aren’t sure what to put in this field, make sure to double check with 
your web hosting provider. A wrong file path can cause your website to be published to 
the wrong location and no accessible via your web browser. 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Widgets

Navigation Menu

EverWeb’s built-in navigation menu makes it easy for users to have a 
navigation menu with links to some or all of the pages on the website. 
Simply drag and drop the Navigation Menu widget onto the editor, and a 
menu with links to all pages on your site will appear.

Tip: If you do not want one or more of your pages included in the navigation menu, make sure to disable 
the ‘Include in navigation menu’ option while on the page. This option is found on the Inspector area, on 
the Page Settings tab, and under the Page Details section.

You can modify the settings of your navigation menu on the ‘Widget Settings’ tab in the 
Inspector. On this tab, you will be able to change the navigation menu’s alignment, 
padding, spacing, and minimum width. You can also change background color and the 
mouse over color for the submenu. Please note that this feature is only applicable to 
those who are utilizing EverWeb’s drop down menus.

If you would like to change the font type and font size of the text, you can do so the way 
you normally would, which is by clicking on the Fonts button in the toolbar and making 
your changes.

If you would like to change the color of the text, including the Rollover and Visited 
colors, you can do so on the Hyperlinks tab. You will be able to do this under the 
Hyperlink Formatting section, by clicking on the color icon next to the format option and 
selecting the color you would like. You can also select if you would like the links to be 
underlined. 

RSS Feed

The RSS Feed widget allows you to place a third-party website’s RSS feed 
on your website. This allows you to provide your website visitors with 
updated content, without having to do anything. 

To use the RSS Feed widget, simply drag and drop the widget onto the editor. On the 
Widget Settings tab, paste or type in the URL for the feed you want displayed on your 
website. 
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You can adjust the widget on your site so that it is bigger, smaller, wider, or more 
narrow. You can also play around with the rest of the settings on the Widget Settings tab 
until you are satisfied with the way the RSS feed is displayed on your website.

Contact Form

To add a contact form to your website, you can drag and drop the Contact 
Form widget onto the editor. On the Widget Settings tab, it is very 
important to enter your email address in the Email Address field. This is the 
email address that will receive any of the messages submitted using this 
contact form. You can edit the fields on the contact form if you want to add 

different fields other than the default fields on your form. For example, if you wanted 
users to submit their full names, you could change the Name field from “Name:” to “Full 
Name:” This will display Full Name and users using your form will know to enter their full 
names. 

Facebook Like

If you or your business has a Facebook page, you can place a Facebook 
Like button on your website. Just drag and drop the Facebook Like widget 
onto the editor. On the Widget Settings tab, enter the URL for your 
Facebook page. 

Google Maps

To add a map to your website, drag and drop the Google Maps widget onto 
the editor. On the Widget Settings tab, enter the address for the location 
you want the map to display. When you are done, click the Apply button. 
You can increase, or decrease the size of the map to suit your needs.

Google Plus

To add a Google Plus button to your website, drag and drop the Google 
Plus widget onto the editor. On the Widget Settings tab, type in or paste 
the URL for the page that you want the Google Plus button to be 
associated with.
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HTML Snippet

The HTML Snippet is the most powerful widget as it allows users to add 
almost anything to their website. Anytime you want to embed, or add an 
item to your website, if you are given an HTML script for that item, you will 
paste it in the HTML Snippet widget. 

Tip: The HTML Widget lets you add any type of code to your website which makes it both powerful and 
having the potential to cause publishing problems if your enter incorrect HTML Code. Make sure you 
know what the code is doing when using the HTML Widget.

Image Slider

The image slider creates a slideshow of images that can be set to 
transition from one image to the next. Drag the image slider onto your 
webpage and then add images using the Choose... button.

PayPal e-Commerce Widget

The Paypal e-commerce widget lets you add either Paypal Buy Now 
buttons or a fully featured Shopping Cart.

Twitter Follow Me

This widget allows you to add a Twitter Follow Me button to your page. 
Simply drag and drop the widget on the editor, and on the Widget Settings 
tab, enter your Twitter handle. 

YouTube Video

If you wish to embed a YouTube video on your website, you can drag and 
drop the YouTube Video widget onto the editor. On the Widget Settings tab, 
type in or paste the link for the YouTube video you want to embed. When 
you are finished, clicked the Apply button. You can modify the size of the 
video to suit your needs.
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